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 RISC Publication Template - User Guide 

Introduction 
The Resources Information Standards Committee (RISC) publication template is designed to assist authors 
with the production of documents conforming to established formatting and page layout standards. In 
addition, the template contains numerous automated procedures designed to relieve authors the burden of 
performing many mundane tasks associated with creating large publications.  

If you have not previously used the template, please read this guide carefully. It contains information that will 
help you exploit all the automated features of the template. 

Please note that authors using the template to create publications need not perform any of the following tasks: 

a) creating styles; 

b) specifying page setup attributes; 

c) inserting section breaks; 

d) creating and formatting headers and footers; 

e) creating a table of contents; 

f) creating a list of figures; 

g) creating a list of tables; or 

h) creating an index. 

Compatibility 
The template is compatible with Microsoft Word 97, 2000, 2003 or 2007 running under Windows 95/98, NT 
Workstation or Server, Windows 2000, Windows XP, or Vista. 
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Installing the Template 
 
On your Workstation:  
The template MUST be saved to the Desktop on a managed machine. 
 
  

 . 
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Starting a New Publication 
After you install the Resources Information Standards Committee publication template, you can use it to 
create a new publication. 

To start a new publication: 

1. Click on the RISCtemplate on your desktop to open Word. 

2. A Security Warning – macros have been disabled   Options box under the tool bar will appear. 

3. Click on the options box and allow macro’s. 

4. The Publication Information dialoge box should come in. 

5. In the New dialog box, fill in the information then click OK to create a new publication based on the 
template. When the new publication starts, the RISC Publication Setup Wizard you by gathering some 
basic information and inserting it into your publication at the appropriate locations. 

6. Read the instructions, then click ok to move to Step One of the wizard. 

7. Enter the full title of your publication in the first text box. 

8. Press the Tab key to move to the second text box. 

9. Enter a short version of your title in the second text box. 

10. Press the Tab key to move to the third text box. 

11. Enter the subtitle of your publication in the third text box. 

12. Click ok to move on. 
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13. Click in the check boxes to indicate the optional sections you want included in your publication. 

14. Click Next> to move to the last panel of the wizard. You can click <Back to move backwards through the 
panels to review or change your information. 

15. Read the information in the panel, and then click Finish. After you have completed the wizard, you will 
be prompted for the location of any image files that you intend to insert into your document. 
Note: You are not required to specify an images folder location. If you do not however, you will not be 
allowed to insert linked images into your document. 

 

16. You can enter a folder path manually or click the Browse button  to find the folder using the standard 
Windows Browse for Folder dialog box. 
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17. When you have specified the folder location, click Save to begin working with your publication. 

 

18. If your publication includes a preface, enter the text then click the Go To Abstract  button to move to 
the abstract. 

19. Enter the text of your abstract, and then click the Go To Start  button to move to the beginning of the 
first regular chapter. Note that the Heading One Style is automatically applied to the first chapter title. 

20. Enter the title of the first chapter, and then press Enter to beginning entering the text. 
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Working Environment 
The publication template includes several custom features designed to assist you in moving through and 
formatting your publication. The most important features are the RISC Tools toolbar and the Special menu. 

RISC WritersTools Toolbar 
The RISC Tools toolbar allows you to quickly accomplish several common publication tasks. 

 
You can learn the functions associated with the toolbar by momentarily resting the mouse pointer directly 
over a button. A message appears on the status bar in the bottom left corner of the document window 
explaining what will happen when you click the button. 

  

Special Writers Tools Menu 
Most of the functions available on the RISC WritersTools toolbar are also available through the Special 
Writers Tools menu. The menu also contains additional functions that will be explained in a later chapter.  
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Moving Through the Publication 
You can use the RISC Writers Tools toolbar to quickly move to several key locations within the publication. 
The table below explains the major publication navigation commands. 

Navigation Function Toolbar Button Menu Command 
Move the insertion point to the 
first paragraph of the publication 
abstract 

 
Go To Abstract 

Move the insertion point to the 
first paragraph of the 
acknowledgments 

 
Go To Acknowledgments 

Move the insertion point to the 
first paragraph of the publication 
preface 

 
Go To Preface 

Move the insertion point to the 
first paragraph of the executive 
summary 

 
Go To Executive Summary 

Move the insertion point to the 
first paragraph of the first regular 
chapter 

 
Go To Start 

Move the insertion point to the 
first paragraph of the 
Cataloguing in Publication data 

 
Go To CIP Page 

Note: In order to avoid removing critical bookmarks, you should use the toolbar or the menu commands to 
navigate the publication rather than manually scrolling through it. 
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Modifying the Publication 
After you have created your publication, you may want to change the title, subtitle or other information 
entered using the setup wizard. You can use the RISC Writers Tools toolbar and menu to quickly change any 
information. The table below explains the major publication modification commands. 

Modification Function Toolbar Button Menu Command 
Change the location of the 
images folder.  

Set Image Folder Location 

Enter or change the publication 
title  

Modify Title 

Enter or change the publication 
short title  

Modify Short Title 

Enter or modify the publication 
subtitle  

Modify Subtitle 

Enter or modify your ministry 
name  

Modify Ministry 

Enter or modify your branch 
name  

Modify Branch 

Enter of modify your task force 
name  

Modify Task Force 

Add or remove optional 
publication sections  

Modify Optional Sections 

Enter or modify the publication 
date and/or version  

Modify Date and Version 

Note: In order to avoid removing critical bookmarks, you should use the toolbar or the menu commands to 
modify the publication information rather than manually editing the text. 
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Using Styles 
In order to promote consistency across publications, the template includes several built-in styles. You must 
use these styles in the appropriate places when creating your publication. Although you can add your own 
styles to accommodate your publication’s unique requirements, you cannot change any of the built-in styles 
without the permission of the Resources Information Standards Committee.  

Buttons are provided on the RISC WritersTools toolbar to assist you in quickly applying the styles to one or 
more paragraphs. The table below explains appropriate usage of the built-in styles and buttons used to apply 
each style. 

Style Command Button Usage 

Heading One 
 

Use Heading One style only for 
chapter titles (included in table of 
contents). 

Heading Two 
 

Use Heading Two style for 
second level headings within 
chapters (included in table of 
contents). 

Heading Three 
 

Use Heading Three style for third 
level headings within chapters 
(included in table of contents). 

Heading Four 
 

Use Heading Four style for 
fourth level headings within 
chapters (not included in table of 
contents). 

Normal 
 

Use Normal style for all body 
text within chapters. Do not use 
this style for headings. 

Bibliography Entry 
 

Use Bibliography Entry style 
only for entries in a bibliography. 
Do not use this style for 
headings. 

Note: If you do not begin each chapter with Heading One style, your publication will not format properly. 

To apply a built-in style to a paragraph: 

1. Place the cursor anywhere in the paragraph to which you want to apply the style. 

2. Click the appropriate button on the RISC Tools toolbar. 
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Creating Numbered Headings 
Some documents require numbering on one or more of the heading levels. While you can manually create this 
numbering using sequence fields, the template provides a quick method for creating numbered headings. 

To create numbered headings: 

1. Choose Style… from the Format menu to open the Style dialog box. 

 
2. From the Styles list box, choose the heading style that you would like numbered. In the example, the user 

has chosen Heading 1. 

 

3. If you wish to have all of your heading styles numbered, click the Outline Numbered tab, and then choose 
a numbering format to apply to all of the heading styles in your document. 
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Working With Pictures and Illustrations 
The publication template makes special provisions for the handling of pictures, illustrations and other graphic 
objects. When working with graphic objects, keep the following points in mind: 

a) When you start a new document based on the template, you would have been prompted 
for an images folder location. All linked graphic objects used in your publication must be 
placed in this directory. 

b) Any graphic image can be pasted directly into your publication. 

c) The template does not allow embedded OLE objects like Excel spreadsheets, Microsoft 
Equation objects, etc. If you wish to use these features, convert the object to an image 
using Paint or any image management application. 

d) All pictures and illustrations must have a caption. The template will automatically prompt 
you for the appropriate caption each time you add a graphic object to your publication. 

To add a picture or illustration to your publication: 

1. Ensure that the file you want to add to your publication is located in the images folder that you previously 
specified. If it is not, copy or move it to the directory. 

2. Click the Image Folder from your Writers Tools menu to open the Image Folder dialog box. 

  
3. Click on the file you want to add to your publication. Do not change directories of any other settings in 

the dialog box. 

4. Click save to insert the graphic object into your publication. The Caption dialog box opens immediately 
after insertion of the picture or illustration. 

  
5. Enter the appropriate caption for the graphic object.  Do not change any settings in the dialog box. 

6. Click OK to add the caption below your picture or illustration. 
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After you have added a picture or illustration, you can change the size, scale or any other property associated 
with the graphic object. Such changes will not interfere with the publication of your document.Working with 
Tables 

The template is not as restrictive with tables as it is with pictures and illustrations. The only requirement is 
that each table must have a caption. 

To add a table to your publication: 

1. Click the Insert Table  button or choose Insert Table from the Table menu to open the Insert Table 
dialog box. 

  
2. Enter the number of columns and rows you want in your table. 

3. Click OK to add the table to your publication. The Caption dialog box opens immediately after insertion 
of the table. 

  
4. Enter the appropriate caption for the table.  Do not change any settings in the dialog box. 

5. Click OK to add the caption above your table. 

After you have added a table, you can format the borders, shading or any element. Such changes will not 
interfere with the publication of your document. 
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Bibliography, Index, and Cross-reference Entries 
The publication template provides several tools to assist you when creating bibliography and index entries. 
While you must manually add a bibliography title and section to your publication, the index title and the 
index itself is automatically created during publication. 

Adding Bibliographies 
If your publication requires a bibliography, you can add it to the end of the document. If you add your 
bibliography after publishing the document, be sure to place it after the last chapter and before the index. 

To add a bibliography to your publication: 

1. Press the Control and End keys at the same time to move to the end of the document. 

2. Press the Enter key to create a new paragraph. 

3. Type “Bibliography” or any other title you wish. 

4. Click the Heading One  button to apply the Heading One style to the title. 

5. Press the Enter key to create a new paragraph below the title. 

Bibliography Entries 
Entries are listed alphabetically by author’s last name. If there are multiple entries by the same author, they 
are listed in chronological order. When there are multiple entries by the same author for the same year, the 
date is followed by a, b, c, etc. (see below). The first line of each entry is left-justified, and subsequent lines 
are indented one quarter inch. 

Note: When adding bibliography entries, be sure to apply the Bibliography Entry style using the Bibliography 
Entry  button in the Writers Tools. 

Examples of citations for references: 

Journals 

Article, one author: 

Johnson, M.K. 1982. Frequency of sampling for microscopic analysis of botanical compositions. J. Range 
Manage. 35:541-542. 

Article, two authors: 

Marshall, J.W., and V.R. Squires. 1979. Accuracy of quantitative methods used for botanical analysis of 
oesophageal fistula samples. Tropical Grasslands 13:140-148. 

Article, corporate author: 

Canada Soil Survey Committee. 1978. The Canadian system of soil classification. Can. Dep. Agric., Publ. No. 
1646. 
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Same authors, more than one publication in the same year: 

Holechek, J.L. and B. Gross. 1982a. Evaluation of different calculation procedures for microhistological 
analysis. J. Range Manage. 35:721-723. 

___ and ___. 1982 b. Training needed for quantifying diets from fragmented range plants. J. Range Manage. 
35:644-647 

Books 

One author: 

Mech, L.D. 1970. The wolf: the ecology and behavior of an endangered species. Nat. Hist. Press, Garden 
City, N.Y. 384pp. 

Editor, compiler or translator as author: 

Capen, D.E., ed. 1980. The use of multivariate statistics in studies of wildlife habitat. U.S. Dep. Agric., For. 
Serv. Gen. Tech. Rep. RM-87. 

Chapter in a book, editor given: 

Severinghaus, C.W., and E.L. Cheatum. 1969. The life and times of the white-tailed deer. Pages 57-186 in 
W.P. Taylor, ed. The deer of North America. Stackpole Co., Harrisburg, Pa. 668pp. 

Work of one author cited by another: 

Marston, H.R. 1948. Energy transactions in the sheep. Aust. J. Sci. Res. 1:93. (Article not seen, citation from 
Blaxter, K. 1962. The energy metabolism of ruminants. Hutchinson and Co. (Publ.) Ltd., London. 329pp.) 

Proceedings, meetings, conferences 

Specific papers from proceedings: 

Carrick, R. 1963. Ecological significance of territory in the Australian magpie, Gymnorhina tibecen. Proc. Int. 
Ornithol. Congr. 13:740-753. 

Cole, G.F. 1983. A naturally regulated elk population. Pages 62-81 in F.L. Bunnell, D.S. Eastman, and J.M. 
Peek, eds. Symposium on natural regulation of wildlife populations. Proc. Northwest Sect., Wildl. Soc., 
March 1978, Vancouver, BC. 225pp. 

Adding Index Entries 

To add an index entry to your publication: 

1. Select the text you want to include in the index. 

2. Click the Index Entry  button. Although you may not notice any change in your publication, the 
selected text is marked and will be included in the index when you publish your document. 

Adding Cross-reference Entries 

To add an index entry to your publication: 
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1. Ensure that the selection point is at the location where you want to insert the cross-reference. 

2. Click the Insert Cross-reference  button in the Writers Tools to open the Cross-reference dialog box.  

3. Define your cross-reference, and then click the OK button to close the dialog box and insert the cross-
reference into your document. 
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Publishing Your Document 
The publication template provides an automated procedure for preparing your final document. The procedure 
ensures standard formatting for all Resources Information Standards Committee publications and relieves the 
writer of many tedious tasks. When you publish your document, the automated procedure applies the 
following changes: 

a) The entire publication is checked for embedded objects or improperly linked graphic 
images. 

b) All existing section breaks are removed. 

c) Section breaks are inserted before each paragraph with Heading One style. 

d) All existing headers and footers are removed. 

e) Headers and footers conforming to Resources Information Standards Committee 
publication formatting guidelines are inserted. 

f) All existing page numbers are removed. 

g) Page numbers conforming to Resources Information Standards Committee publication 
formatting guidelines are inserted. 

h) Existing tables of contents and indexes are removed. 

i) A table of contents conforming to Resources Information Standards Committee 
publication formatting guidelines is inserted. 

j) An index conforming to Resources Information Standards Committee publication 
formatting guidelines is inserted. 

k) All cross-reference fields are updated. 

To publish your document: 

1. Ensure that all graphic objects are properly linked to a file in your image folder directory. 

2. Ensure that all graphic objects and tables have captions. 

3. Ensure that the Preface, Abstract, Executive Summary, and Acknowledgements titles are formatted with 
the Heading 1A style. This is the default style for these titles. If you have not changed the style of these 
titles, you need not check them. 

4. Ensure that each chapter title, other than those mentioned in the previous step, is formatted with the 
Heading 1 style. 

5. From the Special menu, choose Publish. The mouse pointer changes to an hourglass. Do not click the 
mouse button or press any keys while publishing is in process. (This could take several minutes for a 
large document.) 

6. When the Update Version Number and Publication Date dialog box appears, change the version number 
and publication date, if you wish. 
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7. Click OK to update the version number and publication date. 

8. When the Header Text dialog box appears, change the text that will appear in odd and even page headers, 
if you wish. By default, the short title that you specified when creating the document is used in both odd 
and even headers. 

 
9. When the document has been completely published, the Publication Complete dialog box appears. 

 
10. Click OK to complete the process. 
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Improperly Formatted Documents 
The publication template is able to automate the preparation of your final document because the RISC 
template includes many preset styles and bookmarks. If the bookmarks in the document you are publishing 
have been altered or removed, or the styles have been improperly applied, the template may not be able to 
publish the document. If the template cannot publish the document, the Corrupted Document dialog box 
appears. 

 
Should you encounter this dialog box when trying to publish a document, take the following steps to make 
your document publishable. 

1. Ensure that the Preface, Abstract, Executive Summary, and Acknowledgements titles are formatted with 
the Heading 1A style. This is the default style for these titles. If you have not changed the style of these 
titles, you need not check them. 

2. Ensure that each chapter title, other than those mentioned in the previous step, is formatted with the 
Heading 1 style. 

3. If there are tables of contents, list of figures, or list of tables in your document, ensure that their titles are 
formatted with the TOC Title style. 

4. Try publishing the document again. If you still cannot publish your document, contact the Resources 
Information Standards Committee Publications Coordinator for further assistance. 
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Embedded or Improperly Linked Graphic Objects 
If your document contains embedded objects, the following message appears when attempting to publish it. 

 
In this case, you must convert your embedded object – it will be selected after you click the OK button to 
close this message box – into an image (.bmp. gif, .jpg, etc.), and paste it into your document or place it in 
your images folder and link it to your document. 

If your document contains linked images that are not in your images folder, the following message appears 
when attempting to publish it. 

 
In this case, you must copy your image – it will be selected after you click the OK button to close this 
message box –place it in your images folder and link it to your document image field. Alternately, you can 
unlink the image by copying it and pasting into your publication. 
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Inserting Canadian Cataloguing in Publication Data 
The Canadian Cataloguing in Publication Data (CIP data) is derived from the text of your publication 
abstract. After the Resources Information Standards Committee has approved your publication, you will be 
required to request the CIP data from the Legislative Library.  The Library’s preferred methods of receiving 
requests for CIP data are one of the following: 

a) an e-mail attachment of approximately the first 10 pages of the document; or 

b) a hard copy of the first 10 pages faxed to (250) 356-9176; or 

c) a zipped file of the entire document sent via e-mail. 

Contacts at Legislative Library: 
Barbara Elford or Horst Huelscher 

Via E-mail: 

Both contacts are on MS Exchange. Send to: 

Barbara.Elford or Horst.Huelscher 

By Telephone: 

(250) 387-6506 

Shortly after submitting your request, you will receive a Word document or text file from the Library 
containing the CIP data. You must place this information into your publication at the correct location. 

Note: Do not change any of the spacing. 

To insert Canadian Cataloguing in Publication Data into your document: 

1. Open your publication. 

2. Open the file containing the Canadian Cataloguing in Publication Data. 

3. Select the CIP data. 

4. Copy the text to the clipboard. 

5. Switch to your publication. 

6. Click the Go To CIP Data  button or choose Go To CIP Data from the Special menu to move the 
insertion point to the Canadian Cataloguing in Publication Data section. 

7. Paste the CIP data into your publication. 
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Creating RISC Publications From Non-RISC Templated 
Documents 
Occasionally, you may need to convert an older document that has been created without the RISC publication 
template into a standard RISC publication format. The template provides a method to convert such 
documents. 

Note: Because the template has no way of determining exactly how the non-RISC templated document has 
been created and formatted, it is possible that the conversion process may fail or result in a loss of 
data. Only experienced users of the RISC publication template should attempt to convert documents. 

To convert a non-RISC templated document into a standard RISC publication format: 

1. Make a backup copy of the document in case data is lost during the conversion process. 

2. Open the document.  

3. From the Tools menu, choose Templates and Add-Ins… to open the Templates and Add ins dialog box. 

 
4. Click the Attach… button to open the Attach Template dialog box. 
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5. Select the risc2000.dot file, and then click the Open button to return to the Attach Template dialog box. 

 
6. Ensure that the Automatically update document styles check box is checked. 

7. Click OK to attach the risc2000.dot template file to your document. 

8. Ensure that each standard chapter heading is formatted with the Heading 1 style. 

9. Ensure that preliminary section titles, preface, executive summary, abstract, table of contents, list of 
tables, list of figures, etc., are not formatted with the Heading 1 style. You can apply the Heading 1A 
style to these section titles. The Heading 1 style must not be used anywhere in the document before the 
first standard chapter. 

10. Save the document and close it. 

11. Open the document again. The Convert Document dialog box will appear. 
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12. If you are certain that you have prepared the styles properly as outlined in the previous steps, click Yes to 

begin converting the document. If you are not certain that you have prepared the styles properly, click No. 

If you click Yes, the following events will occur: 

a) The template will delete all content from the beginning of the document until the first 
paragraph formatted with the Heading 1 style. 

b) The template will insert the standard RISC title page and preliminary sections into the 
document before any existing chapters. 

c) The RISC Publication Setup Wizard will begin. You must enter all information that you 
would normally enter when creating a new RISC publication. 

Note: The conversion of non-RISC templated documents into standard RISC publication format is a 
hazardous and potentially error-prone procedure. If errors prevent you from converting a document, 
create a new RISC document from the template, and then copy the relevant sections of the non-RISC 
document into your new RISC publication. 
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Preparing Your Publication for the Committee 
The Resources Information Standards Committee must approve your publication before it can be released for 
final publication and commercial printing. The following items must be submitted to the committee: 

a) one laser copy of your publication; 

b) Word and linkable .PDF files of your publication on diskette; and 

c) an electronic copy of your c:\ricimage directory on diskette. 

Creating a PDF File 
After the committee has approved your publication, you must create a linkable .PDF file that will be sent to 
the commercial printer. 

Note: You require the Adobe Acrobat Distiller software to create a .PDF file. 

To create a  .PDF file: 

1. Open Word document. 

2. From the File menu, choose Print. 

3. In the Print dialogue box, select Printer Name…Acrobat Distiller. 

4. Select OK. In the Save PDF File As dialogue box select the location to save the file in the Acrobat 
format. 

5. Click the Save button to save the new .PDF file. 

After the .PDF file has been created on your hard drive, copy it to a diskette and submit it to the committee. If 
the file is too large you may have to compress the file before you copy it to the diskette. 

Note: To ensure that the publication process is not impeded, please make changes required to generate a 
linkable PDF file only AFTER the document has been published. 
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